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Introduction

	Purpose
	This document describes how to install and use the Learner Information Suite (LIS) version 11.03.  LIS 11.03 is used to validate full and mini individualised learner record (ILR) data to learner profiles prior to transmission to the LSC, reconcile learners studying between two or more teaching years, run FE funding and derived data calculations and to run reports against this data.  The LIS also exports valid data for transmission to the Learning and Skills Council (LSC) via Provider Batch.


	Background
	The LIS is a component of the LSC’s data collection systems that enable efficient collection, collation and management of learner information. Other components include:

· Provider Batch

· Provider Online

· Learning Aim Database (LAD).

LIS 11.03 enables all providers to validate ILR data for the 2003/04 teaching year before it is transmitted to the LSC.  LIS 11.03 uses release 3 of the 2003/04 validation rules (as described on the LSC website).  It also enables FE providers to calculate funding and produce learner profiles for transmission to the LSC. 

The application is designed for use by Provider Batch users.

Further documentation is available from the Data area of the Partners section of the LSC website:

http://www.lsc.gov.uk/National/Partners/Data/default.html
Documentation includes:

· ILR Guidance

· Mini-ILR Specification and Validation Rules

· The validation rules used by LIS 11.03

· Roadmap – recommended procedures

· Installation Guide

· Release Guide

· Technical Database Guidance

· Guidance on Interpretation of Results for the Learner Profile.


Continued on next page

Introduction, Continued
	Previous Versions
	LIS series 10 can co-exist with series 11.  LIS 11.03 can therefore be installed on a PC which already has a version of LIS 10 installed.

LIS 11.02 should be uninstalled before installing LIS 11.03 due to a conflict between registry entries for the funding calculation and derived variables components.

Warning: If version 10 has been uninstalled, there is no problem in installing LIS version 11.03.  When uninstalling older versions of LIS (series 9 and previous) do not remove the shared files.  If LIS 9 or earlier has already been uninstalled, reinstall it before attempting to install LIS 11.03.

LIS 11.03 is designed for use with 2003/04 ILR data for WBL, FE, ACL, ESF SR and UfI providers.  Providers should continue to use series 10 for processing their 2002/03 ILR returns.


	Support Materials
	For support:

· check the LIS section of the LSC website’s Data area: http://www.lsc.gov.uk/National/Partners/Data/default.html
· contact your local LSC.


Installing LIS

	Overview
	LIS 11.03 is available for download from the Data area of the LSC website:

http://www.lsc.gov.uk/National/Partners/Data/default.html
The software must be installed onto a PC matching at least the minimum specification required (see below).


	System Requirements
	The minimum hardware specification required to run the software is:

· Pentium II 233MHz (Pentium II 450MHz recommended)

· 64MB of RAM (128MB recommended)

· 100MB of free disk space for holding the application

· 500MB of free disk space for holding data (1GB recommended).

The PC should also support an internet connection to enable providers to check the website for updates.

One of the following operating systems is required:

· Windows 98

· Windows ME

· Windows NT4 SP6a

· Windows 2000

· Windows XP Home or Professional.

Note:  You must have administrator rights on the PC in order to install the software.


	Upgrading to version 11.03 of the LIS 
	If you are upgrading from an older version of LIS you must be aware of the following:

· LIS 11.03 can co-exist on a PC with previous versions of LIS (series 8, 9 and 10).

· The password resets to password by the new installation.  If required, you can change it using the Change Password option.  Please refer to Changing your Password (see page 19) 


Continued on next page

Installing LIS, Continued
	Downloading LIS for Installation
	The installation files for LIS 11.03 are located on the LSC website for all providers to download, unzip and install onto their own PCs.

To download the LIS 11.03 self-extracting installation file from the LSC website:


	Step
	Action

	1
	Launch your internet browser and navigate to the Data pages of the LSC website:

http://www.lsc.gov.uk/National/Partners/Data/default.html


	2
	Select Software - Learner Information Suite, then click Go.


	3
	A list of available versions displays.  For each release of LIS there is a separate information page.

Click Version 11.03 from the list.

The LIS 11.03 information page displays.  Please take the time to become familiar with this page, as it contains useful information about known issues with the software and is updated as new issues arise.



	4
	Scroll down the page to the link for downloading the LIS 11.03 software and click the link.

The LIS 11.03 software download page displays.



	5
	Click the LSC logo displayed next to the file you would like to download from the list.  Choose the Full Installation for LIS 11.03.

The File Download dialogue box displays.



	6
	Select the option to Save this program to disk.  Click OK.

	7
	Select a location to download the LIS application file on your PC.  Click Save.
The file will download to your PC in the location specified.  The download progress displays.


Continued on next page

Installing LIS, Continued
	Unzipping the Downloaded LIS Installation File
	Once downloaded, the self-extracting LIS installation file needs to be unzipped:


	Step
	Action

	1
	Navigate to the location you have saved the file to in step 7 of Downloading LIS for Installation (see page 10).  Double click the file.

A dialogue box appears, confirming whether you wish to continue saving the downloaded files into the specified directory.



	2
	Click OK.

The WinZip Self-Extractor dialogue box appears.



	3
	You now have a choice:

	
	

	
	
	IF…
	THEN…
	

	
	
	You click Browse
	The Choose Folder dialogue box displays.

Select the required location for the installation. 

Click OK.

Click Unzip to unzip the file.


	

	
	
	You click Unzip
	The file will be unzipped to the specified location. You will receive a confirmation.

Click OK.

Click Close to close the WinZip Self-Extractor dialogue box.


	

	
	


Continued on next page

Installing LIS, Continued
	Unzipping the Downloaded LIS Installation File (continued)


	Step
	Action

	3
	

	Cont.
	
	IF…
	THEN…
	

	
	
	You click Run WinZip
	WinZip is launched to unzip the file.


	

	
	
	You click Close
	The dialogue box is closed. Your file is not unzipped.


	

	
	
	You click About
	Displays information about WinZip and the downloaded file.


	

	
	
	You click Help
	Help information displays.


	

	
	


	Running the LIS Installation
	To install LIS you must have administrator rights on your PC.

The software should only be installed onto the hard disk of a PC and not a network drive.  It is recommended that you close down all other applications before installing.

To run the installation:


	Step
	Action

	1
	Navigate to the location where the installation file was unzipped to in step 3 of Unzipping the Downloaded LIS Installation File (see page 11).  Double click the file setup.exe.  The Preparing to Install screen displays.

Cancel aborts the installation.

Once the Preparing to Install screen is complete, the Welcome screen appears.



	2
	Click Next.  The Choose Destination Location dialogue box displays.




Continued on next page

Installing LIS, Continued
	Running the LIS Installation (continued)


	Step
	Action

	3
	

	
	
	If…
	Then…
	

	
	
	You click Browse
	The Choose Folder dialogue box displays.  

Select the required location for the installation. Click OK.

Cancel cancels the selected location and maintains the default setting.

Go to step 4.


	

	
	
	You click Back
	You return to the previous Welcome screen as in step 2.


	

	
	
	You click Next
	The Setup Status screen displays.

Go to step 5.


	

	
	
	You click Cancel
	You exit the installation program.

Please refer to Cancelling the Installation (see page 14).


	

	
	
	
	
	

	4
	Click Next.
The installation begins and the Setup Status screen displays.



	5
	You may need to restart your PC once the installation completes.

Click the radio button to select the option required.

Note: If you are prompted to restart your computer after the software installation it is recommended that you do, to ensure the application will work correctly.  Whether the prompt displays or not depends on your PC configuration.



	6
	Click Finish.

The installation is complete.   A shortcut icon appears on the desktop.  The software is also accessible from the 
Start > Programs list.




Continued on next page

Installing LIS, Continued
	Cancelling the Installation
	You can cancel the installation if required, during steps 1 to 4 of the Running the LIS Installation procedure (see pages 13). 

To cancel the installation:


	Step
	Action

	1
	Click Cancel.  The Exit Setup dialogue box displays.



	2
	Click a button.



	
	
	If…
	Then…
	

	
	
	You click Yes
	The setup programme exits and closes.


	

	
	
	You click No
	The installation program returns to the point when Cancel was clicked and continues with the installation.


	

	
	
	
	
	


Uninstalling LIS

	Overview
	LIS has a facility to enable users to uninstall the software.


	Uninstalling LIS 11.03
	You can un-install the software by either:

· using the Uninstall shortcut from the Start menu

· running setup.exe from the installation folder.

To uninstall LIS 11.03 using the Uninstall shortcut:


	Step
	Action

	1
	Select the Uninstall LIS 11.03 shortcut from Start | Programs | Learner Information Suite | LIS Maintenance | Uninstall v11.03.

A dialogue box appears asking if you want to uninstall the LIS.

	
	
	
	
	

	
	
	If...
	Then…
	

	
	
	You click Yes
	The uninstall program runs and uninstalls LIS 11.03.


	

	
	
	You click No
	The uninstall program terminates.


	

	
	
	
	
	

	2
	Click Yes.

The preparing to remove message displays.

Cancel exits the program.

When complete, the box closes and LIS 11.03 is removed.


Continued on next page

Uninstalling LIS, Continued
	Uninstalling LIS 11.03
	To uninstall LIS 11.03 using setup.exe:


	 Step
	Action

	1
	Navigate to the setup.exe file used to install LIS 11.03 on your PC and double-click the file.  The Preparing to Install screen appears.

Cancel exits the program.



	2
	Once completed, the Welcome screen displays.  Select the Remove radio button.



	3
	Click Next.  The Confirm Uninstall dialogue box displays.



	
	
	If…
	Then…
	

	
	
	You click OK
	Go to step 4.


	

	
	
	You click Cancel
	You return to the Welcome screen as shown in step 2.


	

	
	
	
	
	

	4
	The Setup Status window appears.

Cancel stops the un-installation of LIS 11.03.

On completion, the Maintenance Complete screen displays.

Click Finish.




The Learning Aim Database

	Overview
	The Learning Aim Database (LAD) is an LSC application that holds information on learning aims, associated funding and statistical data.  

This information is used by the LIS and other LSC systems to validate ILR data and to calculate derived variables for all providers.  The FE funding calculations also require information from the LAD.

The Learning Aim Database is available on the Provider Extranet, where providers can search for aim information and download the LAD.  Access is available from:

· the LSC website - navigate via Partners and then Provider Extranet to the Learning Aim Database (http://www.lsc.gov.uk/National/Partners/ProviderExtranet/default.htm)

· the Provider Extranet itself (http://providers.lsc.gov.uk/).

For further details of how to use the Learning Aim Database, please refer to the following which are available on the LSC website:

· LAD User Guide

· LAD Search Tips

· LAD Help File.


	The LAD and LIS
	A LAD extract must be linked to the LIS.

The data in the LAD is updated frequently.  It is recommended that you regularly obtain updated versions to ensure you are working with the most current information.


	Downloading the LAD 
	To download the latest version of the LAD from the LSC website:




	Step
	Action

	1
	Browse to the LSC Provider Extranet:

http://www.lsc.gov.uk/National/Partners/ProviderExtranet/default.htm
The Provider Extranet page displays.



	2
	Click on the Learning Aim database.  The LAD welcome page displays.  Click on LAD downloads.




Continued on next page

The Learning Aim Database, Continued
	Downloading the LAD (continued)


	Step
	Action

	3
	Click on the file you wish to download.  For LIS 11.03 you need a file in Microsoft Access format (.mdb file).  You can download the entire LAD which contains information for 2003/04, 2002/03 and 2001/02, or for the current teaching year, 2003/04.

The File Download dialogue box displays.

During steps 3 to 5, Cancel stops the download.



	4
	Select the Save this program to disk option and click OK.

The Save As dialogue box displays.



	5
	You can change the location and file name for saving to your PC.  When you have completed this, click Save.

The download begins and the Download dialogue box displays.



	6
	On completion of the download the Open and Open Folder buttons become available.



	
	
	IF…
	THEN…
	

	
	
	You click Open
	The file will be opened for you to access and copy to your PC. 

Refer to The Learning Aim Database (see page 16).


	

	
	
	You click Open Folder
	The folder containing the downloaded LAD opens.


	

	
	
	You click Close
	The Download dialogue box closes.


	

	
	You need to link the LAD to the LIS.

Refer to Link to the LAD (see page 33).




Login to LIS
	Overview
	To login to LIS, users need to start the LIS application and require a password. 

Open the LIS from the Start menu or from the desktop.

By default, when the software is installed, the password is set to password.  Users may need to change the password in line with their organisation’s security policy.


	Accessing LIS from Start Menu
	To access LIS 11.03 from the Start Menu click Start > Programs > Learner Information Suite v11.03 >LIS v11.03. 


	Accessing LIS from your Desktop
	To access LIS 11.03 from your desktop double click the LIS v11.03 icon. 

This is automatically created as a desktop shortcut during installation.


	Login to LIS
	To login to LIS:


	Step
	Action

	1
	Start LIS 11.03. 

In the Learner Information Suite Login dialogue box type password into the password field.

Note:  If the password has already been changed then use that password to login.

If you click Cancel, the dialogue box closes and the LIS will not start.



	2
	Click Login.

This logs you into LIS and briefly displays the LIS splash screen.  The Welcome screen displays once the application loads.

You have successfully logged into LIS and can use it.




Continued on next page

Login to LIS, Continued
	Changing your Password
	The LIS password can be changed if required. 

However, note that:

· If you forget the new password, the LIS software must be uninstalled and then re-installed to reset the password back to password
· Each time you upgrade, the password re-sets to password.


	How to Change your Password
	To change the password:


	Step
	Action

	1
	Start LIS 11.03. 

In the Learner Information Suite Login dialogue box, enter your current password into the password field.



	2
	Click the Change checkbox.



	3
	Click Login.  The Change Password dialogue box appears.



	4
	Enter a new password into both the New Password field and the Verify Password field.  The new password and verify password must match.



	5
	Click OK.



	6
	
	
	
	

	
	
	IF…
	THEN…
	

	
	
	The passwords match


	Continue to step 7.
	

	
	
	The passwords do not match


	Continue to step 8.


	

	
	
	
	
	

	7
	The Welcome screen displays.  The password changes and you can use LIS.



	8
	If the passwords do not match an error message appears.  Click OK and go back to step 4.




Navigating Around LIS

	Overview
	To navigate around the LIS, users have two options:

· Menu bar; or

· Navigation tree.

Either of these options can be used to access the screens within the LIS. 

Note:  For clarity later in this User Guide, only the Navigation Tree options are described.


	Navigation using the Menu Bar
	The LIS application menu bar allows users to move around the screens by selecting a menu option and category of screen and then clicking the required item.

The following menu bar is available from within the LIS:
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All categories of collection - ACL, ESF SR, FE, UfI and WBL - are accessed from the same menu options.

Select the collection type, collection code and mini ILR data (if applicable) from the Batch Import screen.


	Navigating the File Menu
	The following step shows the File menu option:


	Step
	Action

	1
	Click File. 

There is only one option available, Exit.

Note:  You can also use Alt-F to access the File menu.

Selecting the Exit option closes the LIS.

Note:  You can also use the Windows close button in the top right hand corner of the application window to close the LIS.




Continued on next page

Navigating Around LIS, Continued
	Navigating the View Menu
	The following steps explain the View menu option:


	Step
	Action

	1
	Click View.
The following options are available:

· ILR Data Viewer

· Funding Data Viewer.

Note:  You can also use Alt-V to access the View menu.



	2
	Select ILR Data Viewer. 

The ILR Data Viewer screen displays.

This screen enables users to view any imported data by:

· Listing all imported ILR data sets

· Searching for specific learners in the imported ILR data

· Viewing details for a selected learner in the imported data 

· Viewing any rule violations for the selected learner in the imported ILR data

· Link to Report Manager which pre-populates the learner reference for filtered reports.



	3
	Select Funding Data Viewer. 

The Funding Data Viewer screen displays.

This screen enables users to view any imported data by:

· Listing imported ILR data and aim sets

· Searching for specific learners in the imported ILR data

· Viewing details for a selected learner in the imported data

· Viewing learning aims for a selected learner in the imported data

· Viewing derived data for a selected learner in the imported data

· Viewing funding data for a selected learner in the imported data

· Viewing calculation steps for a selected learner in the imported data

· Viewing errors for a selected learner in the imported data.




Continued on next page

Navigating Around LIS, Continued
	Navigating the Data Menu
	The following steps explain the Data menu option:


	Step
	Action

	1
	Click Data. 

The following options are available:

· Batch Import

· Export ILR File

· Learner Profile Export

· Calculate Funding Data

· Calculate Derived Data

· Reconciliation

· Delete Reconciliation Data.

Note:  You can also use Alt-D to access the Data menu.



	2
	Select Batch Import.
The Batch Import screen displays.

The Batch Import screen brings together most of the LIS’ functionality into one single screen. It enables users to:

· Select a provider

· Select the correct collection type and period

· Select files for import

· Select mini-ILR

· Link to the LAD

· Import ILR data

· Validate ILR data

· Choose validation type

· Calculate funding data

· Calculate derived data

· Add and Delete files

· Export ILR data

· Export the LIS database

· Export a learner profile

· Save and load defaults

· Run reports and output directly to a printer

· Monitor the status of batch operations.




Continued on next page

Navigating Around LIS, Continued
	Navigating the Data Menu (continued)


	Step
	Action

	3
	Select Export ILR File.

The Export ILR File screen displays.

The Export ILR File screen enables users to:

· Export ILR data to a file or floppy diskettes

· Change the export area path

· Save and load defaults

· Select data type when exporting the ILR data.



	4
	Select Learner Profile Export.

The Learner Profile Export screen displays.

The Learner Profile Export screen enables users to:

· Change the export area path

· Select the collection number for the learner profile export

· Export a learner profile of the imported ILR data.



	5
	Select Calculate Funding Data.

The Calculate Funding Data screen displays.

The Calculate Funding Data screen enables users to:

· Calculate funding based on imported ILR data.



	6
	Select Calculate Derived Data.

The Calculate Derived Data screen displays.

The Calculate Derived Data screen enables users to:

· Run derived data calculations on imported ILR data.




Continued on next page

Navigating Around LIS, Continued
	Navigating the Data Menu (continued)


	Step
	Action

	7
	Select Reconciliation.

The Reconciliation screen displays.

The Reconciliation screen enables users to:

· Select Individual Providers from which to reconcile data

· Select the Mode for the reconciliation files

· Add and delete files

· Reconcile ILR data

· Export files to floppy diskette(s)

· Run a Reconciliation Report

· Monitor the status of the operation.



	8
	Select Delete Reconciliation Data.

Warning boxes are displayed.

The warning boxes enable users to select:

· Delete the reconciliation data.




	Navigating the Reports Menu
	The following steps explain the Reports menu option:


	Step
	Action

	1
	Click Reports.  There is only one option available, Report Manager.
Note:  You can also use Alt-R to access the Reports menu.



	2
	Select Report Manager.

The Report Manager screen displays.

The Report Manager screen enables users to:

· Run reports, with filters, and view the output on screen

· Print reports

· Export reports

· Export the LIS database.




Continued on next page

Navigating Around LIS, Continued
	Navigating the General Menu
	The following steps explain the General menu option:


	Step
	Action

	1
	Click General. 

The following options will be available:

· Validation Rules

· Log

· Options

· Postcodes.

Note:  You can also use Alt-G to access the General menu.

The following menu options are first-tier folders in the LIS navigation tree.



	2
	Select Validation Rules.

The Validation Rules screen displays.

The Validation Rules screen enables users to:

· View the list of validation rules used by the LIS for validating both full and mini ILR data

· View detailed descriptions for rules in the list.

Note:  The list contains all the rules used for validation for all collection types.  The Collections column (Colls) displays categories which identify the type of provision that the rule is applied to.



	3
	Select Log.  

The Log screen displays.  

The Log screen enables users to view a log of all operations carried out by the software since the log was last cleared.




Continued on next page

Navigating Around LIS, Continued
	Navigating the General Menu (continued)


	Step
	Action

	4
	Select Options.  The Options screen displays.

The Options screen enables users to:

· View the status information for the imported ILR data file

· Select a provider

· Truncate the log file

· Clear any locks in the database

· Compact the database

· Update the provider and postcode data lists

· View import errors

· View current version information for the LIS, LAD and Validation Rules.



	5
	Select Postcodes.  The Postcodes screen displays.

The Postcodes screen enables users to:

· Search for and view the postcodes included in the LIS

· Add (Insert) new postcodes

· Delete new postcodes.




	Navigating the Help Menu
	The following steps explain the Help menu option:


	Step
	Action

	1
	Click Help. 

There is only one option available, About Learner Information Suite.
Note:  You can also use Alt-H to access the Help menu.



	2
	Select About Learner Information Suite. 

The About Learner Information Suite screen displays.

The About Learner Information Suite screen enables users to:

· View LIS information

· View system information

· Link to the LIS page in the Data area of the LSC website.




Continued on next page

Navigating Around LIS, Continued
	Navigation using the Navigation Tree
	The LIS navigation tree allows users to move around the screens by expanding and selecting folder items representing the LIS screens.

The navigation tree folders appear on the left hand side of the Welcome screen.


	Step
	Action

	1
	Click on the + symbol to the left of the LIS 2003/04 folder icon to expand the navigation tree. 

Click the required folder to display the relevant screen.


[image: image2.png]Folder ltems

3 Batch Import

0 ILR Data Viewer

2 Caloulate Funding Data
{21 Funding Viewer

{01 Caloulate Deiived Data
{21 Export Learmer Profle.
01 ExportILR File

{21 Report Manager

1 Validation Rules.
DLeg

{23 Options

{0 Postoodes

{23 Reconciliation




Note:  You can use the [image: image3.jpg]


 button to close the navigation tree display.  To restart the navigation tree you must click on the title bar, where the screen title displays, below the menu options.




Using Batch Import

	Overview
	Users can import and/or validate full and mini ILR data from within LIS via the Batch Import screen.

Note:  From the Batch Import screen users can choose to import, validate and run derived data calculations and/or run reports for their ILR data at the same time.  FE providers may also run funding calculations.  These operations can be selected in various combinations.


	Import ILR Data 
	To import and validate ILR data:


	Step
	Action

	1
	Access the Batch Import screen by selecting Batch Import from the navigation tree.

The Batch Import screen displays.




	Change the Collection Type
	The Collection Type field in the Batch Import field must display the code for the Collection Type being imported (FE, WBL, ACL, ESF SR, UfI):


	Step
	Action

	1
	Click the drop down on the Collection Type field to list the collection type.



	2
	Click on the Collection Type required to select it.




Continued on next page

Using Batch Import, Continued

	Change the Collection 
	The Collection field in the Batch Import field must display the code for the Collection Type being imported.

The collection codes automatically display as relevant to the collection type selected (for example, for FE, the collection codes are F01, F02, etc.).


	Step
	Action

	1
	Click the drop down on the Collection field to list the Collection codes.

Note:  If you selected the Collection Type code using:

· FE, the Collection code will be prefixed with a letter F

· WBL, the Collection code will be prefixed with a letter W

· ACL, the Collection code will be prefixed with a letter C

· ESF SR, the Collection code will be prefixed with a letter S

· UfI, the Collection code will be prefixed with a letter U.



	2
	Click on the Collection code required to select it.
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Using Batch Import, Continued
	Select Mini ILR Data
	The Mini ILR checkbox allows you to choose to import a mini ILR data file instead of a full ILR data file.

The format is based on the ILR, incorporating only fields that directly affect the funding calculations and are required to produce reports.
The mini ILR does not include header or footer records and contains only parts of the learner and learning aim data sets from the full ILR.  A specified file name format is not enforced and when adding files in Batch Import, the ‘List Files of Types’ is set to *.*.
The imported mini ILR data file is validated using the mini-ILR validation rules, as specified in the LSC published document LIS 2003/04 Mini ILR Validation v1.0 and can be validated as either full validation or funding rule subset validation.


	Step
	Action

	1
	Click the Mini ILR checkbox.

The following options are disabled and greyed out:

· Provider's details and Change Provider Button

· Calculate Derived Data

· Collection Type

· Collection Period 

· Export ILR

· Export Learner Profile.

Once mini ILR data has been imported into LIS the following menu options are disabled:

· Calculate Derived Data

· Export Learner Profile

· Export ILR File.

Mini ILR and Validation Reports can be run against the imported data, the available reports are detailed in the Running Reports section (see page 51).
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Using Batch Import, Continued

	Change the Provider
	The first time you use LIS 11.03 you need to change the Provider field to your specific provider number and name.

Note:  If you use more than one provider number for transmitting ILR data, you must ensure the provider field displays the correct provider number and name for the ILR data you are currently importing.  If the provider number does not match the provider reference within the ILR file name, the ILR import process will fail and the validation will not run.

Provider numbers are issued by LSC National Office – any problems should be referred to your local LSC office.

To change the provider:


	Step
	Action

	1
	Access the Batch Import screen by selecting Batch Import from the navigation tree.

Click the Change Prov button.

The Provider Selection window displays.



	2
	To find your provider name, type the first few characters of the name into the Find field.  The list scrolls as you type until the provider name matches the characters typed.

You can also search by entering the whole provider number in the Find field.  Alternatively, use the vertical scroll bar to scroll to your provider name and number.

Highlight the entry in the list.
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Using Batch Import, Continued

	Change the Provider (continued)


	Step
	Action

	3
	Click OK

A dialogue box displays to confirm deletion of the previous provider.

Note:  This dialogue box only displays if a previous provider was selected.  If there was no provider selected, the prompt does not appear.



	
	
	
	
	

	
	
	IF…
	THEN…
	

	
	
	You want to change the provider name and delete any data previously imported for another provider


	Click Yes.

You return to the Batch Import screen and the new provider name and provider number you selected displays.


	

	
	
	You do not want to change the provider name and delete any data previously imported for another provider
	Click No. 

You return to the Batch Import screen and the provider is not changed.


	

	
	

	
	Note:  You can also change provider details from the Maintenance Tab of the Options screen by clicking on the Change Prov... button.
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Using Batch Import, Continued

	Link to the LAD
	In order to validate your ILR data you must link LIS to the most recent version of the LAD. 

Refer to The Learning Aim Database, Downloading the LAD from the Website section (see page 16), for details of how to download the LAD tables.

To link LIS to the LAD complete the following steps:


	Step
	Action

	1
	Access the Batch Import screen by selecting Batch Import from the navigation tree.

If this is the first time you have linked to the LAD the Learning Aim Database Version and Location fields will be blank, otherwise they will be filled with the details for the previously linked LAD.



	2
	Click the Change LAD… button.

The Select Path to Learning Aim Database window displays.



	3
	Use the explorer window to navigate to and select the most recent version of the LAD MDB.

Click OK.

You return to the Batch Import screen, where the Learning Aim Database Version and Location fields are populated with the details of the new LAD extract.
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Using Batch Import, Continued

	Add ILR Data File
	To add an ILR Data file to import/validate, complete the following steps:


	Step
	Action

	1
	Access the Batch Import screen by selecting Batch Import from the navigation tree.

If this is the first time you have selected a file for import, the Import Area and Files selected to import fields will be blank. 

If a file has been imported previously, the fields will contain those details. They can be removed using the Delete Files facility as described in step 2.

Click the Add Files… button.  The Add ILR file to batch window displays.

Navigate to the directory that contains the ILR file(s) to be imported and select the file(s).  If using multiple files, you must add each separately.

If an incorrect provider, collection type or collection period have been selected, or if the file is not named correctly, the files will not be visible.



	2
	Click OK.

You return to the Batch Import screen.  The Import Area and Files selected to import fields display details of the file selected for import.

Note:  If there is any ILR data already present within LIS, it will be deleted when the new data is imported.  LIS copies the ILR data file(s) selected – the original file is not affected.

Once the import completes, you can delete the file(s) from the LIS import area by selecting them and clicking the Delete Files button. 
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Using Batch Import, Continued

	Select Operations
	The Select Operations area of the Batch Import screen allows you to select which processes to run:

· Import ILR Data – this operation checks the ILR data file against import validation rules, reports on any errors and only imports the file once it passes import validation checks. 

· Validate Data – this operation validates ILR data against the ILR validation rules and reports any errors.  This operation only runs once the ILR is successfully imported into LIS.  Select full or FE funding only validation rules.  Full validation is the default selection.

· Calculate Funding – this operation calculates FE funding for the imported and validated ILR.  It generates funding for any learners who are valid according to the FE funding validation rules.

· Calculate Derived Data – this operation calculates derived data for any learners who are valid according to the FE funding validation rules.

The LIS disallows the operation tick boxes where those processes are unavailable for the collection type selected.  For example, ACL collections cannot be used to calculate FE funding, so this option is removed.  However, all data types can be imported and validated, so these tick boxes always remain usable.

If all the operations are selected, LIS attempts to import the ILR data file first and, provided there are no import errors, it then validates the data.  It will complete the FE funding, then the derived data calculations.

When the Mini ILR checkbox is selected, the derived data calculation option will not be available.

To enable Select Operations to run, complete the following steps:


	Step
	Action

	1
	Access the Batch Import screen by selecting Batch Import from the navigation tree.

Check the Select Operations box(es) for the required operation(s).

Note:  The validate data, calculate funding data and calculate derived data operations can be run at a later stage if required.  Select the operations required at this point.  However, the Import ILR Data and Validate Data operations must be done before running the derived data or funding calculations.
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Using Batch Import, Continued
	Selecting the Type of Validation 
	Select the type of validation applied by the LIS by checking the appropriate radio button, either:

· All Validation Rules; or 

· FE Funding Rule Subset.

The validation rules will only be applied if you have selected the validation operation.  The funding rule subset can be used if you are particularly interested in resolving funding-related validation errors.

Mini ILR data is validated against the Mini ILR validation rules.

Note:  Refer to the Calculate Funding section (see page 51) for more details of the effect of choosing the FE Funding Rule Subset.


	Export ILR data 
	Within the Export Options area of the Batch Import screen you have the facility to export the ILR data ready for transmission to the LSC using the Provider Batch data collections process.

Note:  This feature exports totally valid ILR data ONLY and any invalid data WILL NOT be exported.  The export file must therefore be viewed with the knowledge that it contains valid records only and may not be a reflection of the ILR data file originally imported.  Data which is validated using FE Funding Rules only may not be fully valid and therefore may not be exported.

To export data to a file for transmission to the LSC, export the file to a folder on your PC.  The default location is C:\LIS\Release11\1102\exports. 

To export ILR data to a file:


	Step
	Action

	1
	On the Batch Import screen check the ILR check box.



	
	
	IF...
	THEN...
	

	
	
	This is the first time you are exporting ILR data
	The Change… button will activate, go to step 3.


	

	
	
	You have previously exported ILR data
	The Change… button will activate and the file directory of the last export displays.  Go to step 2.
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Using Batch Import, Continued
	Export ILR data (continued)


	Step
	Action

	2
	Check the file directory displayed:

	
	

	
	
	IF...
	THEN...
	

	
	
	You want to change the directory to which the ILR data exports


	Go to step 3.
	

	
	
	If you want the directory for the ILR export to remain the same


	Go to step 5.
	

	
	
	
	
	

	3
	Click Change….

The Select Export File Path window displays.



	4
	Use the explorer window to navigate to and select the directory for your ILR data export and click OK.

You return to the Batch Import screen.



	5
	The ILR field displays details of the directory selected for the ILR export.

Note:  You can also export to a floppy diskette if required, by selecting the floppy disk drive.  A disk must be inserted into the drive. 

Note: The LIS will not burn a file to CD.



	6
	Continue to set up the Batch Import screen as required. 

Refer to Import ILR Data using Batch Import (see page 28).



	7
	You can view the exported ILR data file and transmit it to the LSC using the Provider Batch data collections process.
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Using Batch Import, Continued
	Export DB (database)
	LIS provides the Export DB function to allow the user to view and manipulate the data held within the internal LIS database. 

Note:  This function does NOT create a file that is suitable for transmission to the LSC.  Files sent to the LSC must be exported via ILR Export (see page 36).

To use the Export DB facility:


	Step
	Action

	1
	On the Batch Import screen click the checkbox alongside DB:

The default path displays - C:\LIS\Release11\1103\Exports - and the Change button is activated.



	2
	Check the file directory displayed and:



	
	
	IF...
	THEN...
	

	
	
	You want to change the directory to which the database exports


	Go to step 3.
	

	
	
	You want the directory for the database export to remain the same


	Go to step 5.
	

	
	

	3
	Click Change…
The Select Export Database Path window displays.



	4
	Use the Select Export Database Path dialogue box to navigate to and select the directory for your database export and click OK.

You return to the Batch Import screen.

The DB field displays the directory selected for the database export.



	5
	Select the export format by clicking the radio button next to the required format.

Once the batch process completes you can view the data by opening the file from the directory selected in Step 4.
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Using Batch Import, Continued
	Select Reports
	The Select Reports area of the Batch Import screen allows you to select reports to be automatically produced when the batch process is run.  You can also just run reports by de-selecting the operations checkboxes.  There are a number of reports available within LIS 11.03.  Please refer to the Running Reports section (see page 51) for a list of available reports and their descriptions.

Note:  Reports run from Batch Import are output directly to a printer.  You must have a printer connected to your PC or network to use this function, otherwise the entire batch process aborts.

Note:  Because of the length of the reports that may be produced, it is recommended that you only produce the following reports from the Batch Import screen: 

· Rule Violations Summary

· Rule Violations Summary by LSC 

· Learner Profile

· Summary of Funding by Category

· Summary of Funding with Disadvantage

· Funding Included and Excluded by ILR Export

· Calculation Errors (very rarely long)

· Summary by Allocation Type

· Summary by Franchised Out Arrangement

· Funding by Learner Profile Category.

To select which reports to produce:


	Step
	Action

	1
	On the Batch Import screen, click the drop down arrow next to the first of the Select Reports field.

The list of available reports displays.



	2
	Click on the required report.

The selected report displays in the Select Reports field.



	3
	Repeat steps 1 and 2 for additional reports required.
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Using Batch Import, Continued
	Saving Defaults
	The Save Defaults button allows you to save the selections made on the Batch Import screen (and other screens where it appears).

If you wish to save your selections as defaults, click Save Defaults.

Note:  You may overwrite the default selections as required.  The next time that you click Save Defaults it will overwrite the existing defaults with the new selections.


	Loading Defaults
	The Load Defaults button allows you to recall previously saved defaults.

Click the Load Defaults button to recall the defaults.

The Batch Import screen displays with defaults loaded.


	Starting the Batch Process 
	To start the import/validate process:


	Step
	Action

	1
	Click the Start button to start the processes selected.

The processes start.  Status and progress are displayed.



	
	
	IF...
	THEN...
	

	
	
	You wish to cancel the process once it has started
	Go to Cancel the Batch Process (see below).


	

	
	
	You receive an import error message


	Go to What if the Import Process Aborts 

(see page 41).


	

	
	
	You receive a confirmation that the process has completed successfully


	Click OK and go to your required next action.
	

	
	
	
	
	


	Cancel the Batch Process
	Click the Cancel button to cancel the process at any time while it is running.  

Note:  Before the process is started, and after it has run, the button is de-activated.
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Using Batch Import, Continued
	What if the Batch Process Aborts
	The batch process will fail if the file does not meet the requirements of the import validation rules.  Consult the Import rules on the ILR validation rules spreadsheet.

If you receive an import error dialogue box, complete the following steps:


	Step
	Action

	1
	Take a note of the error message and click OK.

A second dialogue box explains that the batch process has been aborted.



	2
	Click OK.

You return to the Batch Import screen.



	3
	Use LIS Rule Violations reports to obtain details of the error.

Refer to Running Reports (see page 51).



	4
	Correct the error in your local MIS and import the new ILR data file.

Refer to Using Batch Import (see page 34).




	Check the Results of the Selected Operations
	Once you have run the process you are able to check the results of the operations you selected.  This is usually only useful when the batch process has not worked correctly, and when requesting support.




	Step
	Action

	1
	Open the Log screen by selecting Log from the navigation tree.

The Log screen displays.

View the results of your selected operations.  The most recent are at the bottom of the list.  Use the vertical scroll bar if required.




Viewing ILR Data

	Overview
	Although you cannot amend any ILR data from within the LIS you can view the data.  Using the Individualised Learner Record 2003/04 Specification can be very helpful when viewing ILR data.


	Viewing ILR Data Items
	You can view the imported ILR data using the ILR Data Viewer screen within LIS.

To view imported data:


	Step
	Action

	1
	Access the ILR Data Viewer screen by selecting ILR Data Viewer from the navigation tree.

The ILR Data Viewer screen displays.

Note:  No ILR data is visible at this stage. 

Refer to:

· Listing All ILR Data (see below)

· Searching for ILR Data (see page 45).




	Listing All ILR Data
	You can choose to list all imported ILR data. 

To list all the data from the ILR Data Viewer screen:


	Step
	Action

	1
	Click on the All Records icon [image: image4.jpg]


 to list all records.

A list displays on the Learner Records tab.

The list shows all imported ILR data records for you to view.

Move through the list using the navigation buttons.

A scroll bar is available if all the records are not visible.

Note:  When you are at the start or the end of the list some of the navigation buttons will be active or inactive accordingly.

Note:  If you have more than 100 learner records to view only the first 100 displays.  A message displays to advise you of this fact.  Click on OK to proceed.

Use the filter options for learner surname and learner reference to return more specific results.
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Viewing ILR Data, Continued
	Listing All ILR Data (continued)


	Step
	Action

	2
	Click on a learner in the list.

Name and Learner Reference of the selected learner appears in the Learners fields above the Learner Records tab.

Refer to Viewing Learner Details (see page 46).




	Navigating around the ILR  Data Viewer screen
	The ILR Data Viewer screen has two levels of ‘tabs’, allowing you to view different sub-sets of data.  This information is read only and cannot be changed.

Common header information displays across the top of the screen. 

To navigate around the ILR Data Viewer:


	Step
	Action

	1
	Click on one of the Top level data tabs:

The options available are:

· Learners

· Aims & ESF

· Aims & HE

· Rule Violations.

Once one of the tabs has been selected, a sub-set of tabs is available allowing more data to be viewed.

The details for each selected learner can be viewed in the same format as the paper-based ILR form used by WBL and ESF.  For example, L01 (Provider Number) is the first question on the ILR Form and the first column in the learner record.



	
	
	
	
	

	
	
	IF…
	THEN…
	

	
	
	You click on the Learners tab
	The following options are available: 

· Learner Records

· Learner Details 1

· Learner Details 2

· Learner Details 3.
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Viewing ILR Data, Continued
	Navigating around the ILR  Data Viewer screen (continued)


	Step
	Action

	
	
	
	
	

	
	
	IF...
	THEN...
	

	
	
	You click on the Aims and ESF tab
	The following options are available:

· Aims/ESF Records

· Aim Details 1

· Aim Details 2

· Aim Details 3

· ESF Details 1

· ESF Details 2

· ESF Details 3.


	

	
	
	You click on the Aims & HE tab
	The following options are available:

· Aims/HE Records

· Aim Details 1

· Aim Details 2

· Aim Details 3

· HE Details 1

· HE Details 2.


	

	
	
	You click on the Rule Violations tab
	The Rule Violations screen displays.
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Viewing ILR Data, Continued
	Searching for ILR Data
	You can search for specific imported ILR learners if required.  When using search within LIS you can use wildcards.  * and % enable you to search using partial information.  ? represents individual characters when searching using partial information. 

To search for specific ILR data items:


	Step
	Action

	1
	From the Enter Search Text area, use the drop down to select the search type as either Surname or Learner Ref.



	2
	Enter a surname or learner reference in the Enter Search Text field, using wildcards if required.



	3
	Click [image: image5.jpg]


 to start the search.



	
	
	IF...
	THEN...
	

	
	
	A match is found
	The result(s) show in the list.

The search results display the number of records matched and listed.  The search is complete.


	

	
	
	No match is found
	An error message displays.

Go to step 4.


	

	
	
	
	
	

	4
	Click OK and check your search text. 



	5
	Enter a valid search text using steps 1 to 3 as above.
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Viewing ILR Data, Continued
	Viewing Learner Details
	When an ILR data item has been selected, it is possible to view details of the learner, any associated learning aims and rule violations, using the different tab sections of the ILR Data Viewer screen.

To view learner details: 


	Step
	Action

	1
	Select a learner, either by using search or highlighting an item in the learner list.

The fields at the top of the ILR Data Viewer screen are populated with the selected record.



	2
	You can view details for the selected learner by clicking on one of the available tabs.



	
	
	IF...
	THEN...
	

	
	
	You wish to view the selected learner’s details.


	Go to steps 3 - 5.
	

	
	
	You wish to view the aims and ESF details associated with the selected learner’s aims.


	Go to steps 6 - 8.
	

	
	
	You wish to view the aims and HE details associated with the selected learner’s aims.


	Go to steps 9 – 10.
	

	
	
	You wish to view rule violations associated with the selected learner.


	Go to step 11.
	

	
	

	3
	Click on the Learners tab.



	4
	Click on the Learner Records tab to see all learners, or the results of a search.



	5
	Click on one of the Learner Details tabs.

The relevant Learner Details tab screen displays.
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Viewing ILR Data, Continued
	Viewing Learner Details (continued)


	Step
	Action

	6
	Click on the Aims and ESF tab.



	7
	Click on the Aims/ESF Records tab.

The Aims and ESF summary screen displays.

Note:  For more information about the Aim Records and ESF Data Records column labels please consult the ILR 2003/04 Specification available to download from the Data section of the LSC website (www.lsc.gov.uk).



	8
	Click on one of the Aim Details or ESF Details tabs.

The requested Aim Details screen displays.



	9
	Click on the Aims and HE tab.

The Aims/HE Records summary screen displays.

Note:  For more information about the Aim Records and HE Data Records column labels please consult the ILR 2003/04 Specification 



	10
	Click on one of the Aim Details or HE Details tabs.

The requested screen displays.



	11
	Click on the Rule Violations tab.

This displays the Rule Violations tab screen.

Note:  For more information about the validation rules applied by LIS, please refer to the Data area of the Partners section of the LSC website (www.lsc.gov.uk). 




Calculating Derived Data

	Overview
	Derived data (derived variables) are calculated for several reasons:

· they are used in the preparation of the learner profile and the funding calculations

· they allow consistency of definitions between local LSC offices and providers

· providers can use the derived variables for their own reporting purposes.

Only valid learners (against the funding subset validation rules) are passed to this module.

FE and UfI learners can be validated against the FE funding subset validation rules.  All other learner types must be fully validated.

This section describes how to run derived data calculations.

You can run derived data calculations using either the:

· Batch Import screen; or 

· Calculate Derived Data screen.

The derived data calculations must be completed before producing a learner profile.

To run the derived data calculations using the Batch Import screen refer to Using Batch Import – Select Operations (see page 35).

Running the derived data calculation using the Calculate Derived Data screen is described on the next page:
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Calculating Derived Data, Continued
	Calculating your Derived Data
	To calculate the derived data first import and validate your ILR data file.

To complete the derived data calculations:


	Step
	Action

	1
	Click the Calculate Derived Data on the navigation tree to display the screen.



	2
	Click Derive Data.

The LIS will run the derived data calculations by:

· Exporting learner and aim data

· Calculating the derived data

· Importing derivation results.

Click Cancel to abort the calculations.

On successfully completing the calculations a confirmation message displays.



	3
	Click OK.

The calculations are complete.
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Calculating Derived Data, Continued
	List of Derived Variables present in LIS
	The following is a list of the derived variables calculated by the LIS.  These derived variables allow providers to carry out analyses similar to the LSC.

Note:  Not all of these derived variables are used by the learner profile.

Note:  Refer to the Guidance on Interpretation of Results for the Learner Profile for additional information on derived variables and the learner profile.


	Variable Name
	Definition
	Level

	A_NVQLEV
	Notional NVQ level of the aim, taken from the LAD:

1: Level 1 and Entry

2: Level 2

3: Level 3

4: Level 4 or 5 or Higher

9: Other.
	Aim

	L_NVQLEV
	NVQ level of the learner in-year. If the learner has more than one aim, the highest NVQ level is taken. Options are the same as above.
	Learner

	A_ATYPE
	Type of aim, calculated by linking the learning aim reference to the LAD.

Options are:

1: GCE A/AS/A2 level

2: GCSE

3: GNVQ precursor

4: GNVQ/AVCE

5: NVQ

6: Access to HE

7: HNC/HND

8: OCN

9: Additional NVQ/GNVQ

10: Other.
	Aim
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Calculating Derived Data, Continued
	List of Derived Variables present in LIS (continued)


	Variable Name
	Definition
	Level

	L_ATYPE
	Type of in-year aim at learner level. If a learner has more than one aim, the aim used is the one with the maximum current year guided learning hours.

Options are:

1: GCE A/AS/A2 level

2: GCSE

3: GNVQ precursor

4: GNVQ/AVCE

5: NVQ

6: Access to HE

7: HNC/HND

8: OCN

9: Additional NVQ/GNVQ

10: Other.
	Learner 

	A_ACT_A
	Actual current year guided learning hours for the aim using census dates 1 Nov, 1 Feb, 15 May.
	Aim

	A_EXP_A
	Expected current year guided learning hours for the aim using census dates 1 Nov, 1 Feb, 15 May.
	Aim

	L_ACT_A
	Actual current year guided learning hours using 1 Nov, 1 Feb, 15 May.
	Learner

	L_EXP_A
	Expected current year guided learning hours using 1 Nov, 1 Feb, 15 May.
	Learner

	A_LIVE_A
	This is a flag that says whether the aim is active within that teaching year, and uses 
1 Nov as first census date.

Options are:

3:
always included (use where all learners are to be included in the analysis)

2:
included on actual (learners who were not expected to be at the provider [using expected end dates] but were [using actual end dates])

1:
included on expected (learners who were expected to be at the provider but were not)

0:
not included (learners with start and end dates outside the current teaching year).
	Aim
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Calculating Derived Data, Continued

	List of Derived Variables present in LIS (continued)


	Variable Name
	Definition
	Level

	L_LIVE_A
	This is a flag that says whether the learner is active within that teaching year using 
1 Nov as first census date.

Options are:

3:
always included (use where all learners are to be included in the analysis)

2:
included on actual (learners who were not expected to be at the provider [using expected end dates] but were [using actual end dates]

1:
included on expected (learners who were expected to be at the provider but were not)

0:
not included (learners with start and end dates outside the current academic year).
	Learner

	A_ACT_B
	Actual current year guided learning hours for the aim using 1 Oct as first census date.
	Aim

	A_EXP_B
	Expected current year guided learning hours for the aim using 1 Oct as first census date.
	Aim 

	L_ACT_B
	Actual current year guided learning hours for the aim using 1 Oct, 1 Feb, 15 May.
	Learner 

	L_EXP_B
	Expected current year guided learning hours for the aim using 1 Oct, 1 Feb, 15 May.
	Learner

	A_LIVE_B
	This is a flag that says whether the aim is active within that teaching year, and uses 1 Oct as the first census date.

Options are:

3:
always included (use where all learners are to be included in the analysis)

2:
included on actual (learners who were not expected to be at the provider [using expected end dates] but were [using actual end dates]

1:
included on expected (learners who were expected to be at the provider but were not)

0:
not included (learners with start and end dates outside the current academic year).
	Aim
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	List of Derived Variables present in LIS (continued)


	Variable Name
	Definition
	Level

	L_LIVE_B
	This is a flag that says whether the learner is active within that academic year, and uses census dates 1 Oct, 1 Feb and 15 May.

Options are:

3:
always included (use where all learners are to be included in the analysis)

2:
included on actual (learners who were not expected to be at the provider [using expected end dates] but were [using actual end dates]

1:
included on expected (learners who were expected to be at the provider but were not)

0:
not included (learners with start and end dates outside the current academic year).
	Learner

	L_FUND
	Learner’s funding stream

Options are:

1:
FE only

10:
WBL only

11:
FE and WBL

80:
Other fund only

99:
No LSC fund

100:
ESF only

101:
ESF and FE

110:
ESF and WBL

111:
FE, ESF and WBL. 
	Learner

	L_MODE_A
	In-year mode of attendance, using census dates 1 Nov, 1 Feb and 15 May, for all FE aims of the learner is calculated using A_ACT_A and A_EXP_A to give a total CYGLH figure for the learner.  This is then converted into whether they are one of the following options:

1: Full-time full-year

2: Full-time part-year

3: Part-time – other including e-learning

4: Part-time – open

5: Part-time - distance learning

6: Part-time - evening.
	Learner 
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Calculating Derived Data, Continued

	List of Derived Variables present in LIS (continued)


	Variable Name
	Definition
	Level

	L_MODE_B
	In-year mode of attendance, using census dates 1 Oct, 1 Feb and 15 May, for all FE aims of the learner is calculated using A_ACT_A and A_EXP_A to give a total CYGLH figure for the learner.  This is then converted into whether they are one of the following options:

1: Full-time full-year

2: Full-time part-year

3: Part-time – other including e-learning

4: Part-time – open

5: Part-time - distance learning

6: Part-time - evening.
	

	A_AGEST
	Age of the learner as at the start date of the aim.
	Aim

	A_AGESTB
	A_AGEST banded into the following age bands:

1: under 16

2: 16-18

3: 19-20

4: 21-24

5: 25-59

6: 60 and over

9: missing age.
	Aim

	L_AGE
	Age of the learner as at 31 August 2003. 
	Learner 

	L_AGEB
	Age of the learner as at 31 August 2003 (i.e. L_AGE) banded into the following age bands:

1: Under 16

2: 16-18

3: 19-20

4: 21-24

5: 25-59

6: 60 and over

9: missing age.
	Learner

	A_UFI
	A flag to identify if the aim is UfI (University for Industry) or not.

Values are:

0:
non-Ufi

1:
Ufi.
	Aim
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Calculating Derived Data, Continued

	List of Derived Variables present in LIS (continued)


	Variable Name
	Definition
	Level

	L_UFI
	A flag to identify if the learner is a UfI learner – calculated by aggregating A_UFI to learner level.

Values are:

0:
non-UfI

1:
UfI.
	Learner

	A_BSKILL
	A flag to identify if the aim is Basic Skills or not (obtained by linking to the LAD).

Values are:

0:
non-Basic Skills

1:
Basic Skills.
	Aim

	L_BSKILL
	A flag to identify if the learner is Basic Skills or not – calculated by aggregating A_BSKILL to learner level.

Values are:

0:
non-Basic Skills

1:
Basic Skills.
	Learner 

	L_DISADV
	A flag to identify if the learner is considered to be disadvantaged or not (link to uplift).

Values are:

0:
Not disadvantaged

1:
Disadvantaged.
	Learner

	L_FTELP
	The Full-Time-Equivalence of the learner, using the census dates 1 Oct, 1 Feb and 15 May.  Calculated as total expected cyglh/450.  (If the learner is doing more than 450 current year guided learning hours, the value is rounded down to 1 FTE).
	Learner 

	A_TARGET
	A flag to identify if the aim counts towards the NVQ level 2 and/or level 3 and/or Basic Skills national targets.

Values are:

0:
Does not count

1:
Counts.
	Aim
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Calculating Derived Data, Continued
	List of Derived Variables present in LIS (continued)


	Variable Name
	Definition
	Level

	L_TARGET
	A flag to identify if the learner counts towards the NVQ level 2 and/or level 3 and/or Basic Skills national targets  – this is calculated by aggregating A_TARGET to learner level.

Values are:

0:
Does not count

1:
Counts.
	Learner 

	L_ADDSUP
	A flag to identify if the learner is eligible for learner support or not.

Values are:

0:
Not eligible

1:
Eligible.
	Learner


Producing a Learner Profile

	Overview
	The Learner Profile (also known as the Termly FE Learner Profile and previously referred to as the Aggregate Return) will be used:

· to measure in-year progress towards the LSC’s targets

· by local LSCs and institutions at dialogue meetings about in-year performance.

The learner profile is generated using LIS 11.03.  For 2003/04 the learner profile should be transmitted by FE providers to the LSC three times a year, according to the following timetable for collections:

Collection

Collection Reference

Reference Date

Return Date

Autumn 2003

AGG – A01

1 October 2003

20 October 2003

Spring 2004

AGG – A02

1 February 2004

17 February 2004

Summer 2004

AGG – A03

15 May 2004

2 June 2004




	Exporting a Learner Profile
	To run a learner profile:




	Step
	Action

	1
	Import your ILR data file.

Refer to Using Batch Import – Import ILR Data using Batch Import (see page 28).



	2
	Validate your ILR data.

Refer to Using Batch Import – Import ILR Data using Batch Import (see page 28).



	3
	Run the derived data calculations.

Refer to Calculating Derived Data (see page 48).
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Producing a Learner Profile, Continued
	Exporting a Learner Profile (continued)


	Step
	Action

	4
	Access the Export Learner Profile screen.



	5
	Click Change to change the location of the exported learner profile if required.



	6
	Select the correct Collection.



	7
	Click Export.

(Cancel stops the learner profile export.)

Confirmation displays once the export is complete.



	8
	Click OK.

The file produced by the export is suitable for transmission to the LSC.




	Viewing your Exported Learner Profile
	To view the exported learner profile you can either:

· use the Learner Profile report; or

· view the exported file using a text editor.

Refer to the Running Reports section (see page 51) for details of how to run and view the Learner Profile report.


	Export Learner Profile 
	Within the Export Options area of the Batch Import screen you can export the Learner Profile for transmission to the LSC using the Provider Batch data collections process.

To export data to a file for transmission to the LSC you must first export the file to a folder on your PC.  The default location is C:\LIS\Release11\1103\exports. 

To export your Learner Profile to a file:


	Step
	Action

	1
	On the Batch Import screen check the LP check box.



	2
	Follow steps 2 - 7 for Using Batch Import – Export ILR (see page 36).




Calculating Funding Data

	Overview
	The funding calculations allow: 

· providers to calculate the funding generated by their ILR data for 2003/04, based upon their validated ILR returns

· the LSC to use the same algorithm to calculate funding due to providers based on the ILR returns transmitted throughout the year.

You can run the funding calculations using either the:

· Batch Import screen; or

· Calculate Funding Data screen.

The funding calculation option is not available when using the ACL, ESF Short Record or WBL menus.

Before calculating the FE funding the ILR data must have been imported and validated.

Note:  The funding calculation module uses all learners that passed the Funding Rule Subset of the validation rules (regardless of the type of validation chosen).  You should be aware that this may result in a discrepancy between what the LIS calculates and what the LSC calculates.  This is because the LSC use your exported ILR data, which includes only records that passed ALL validation rules.  To obtain a matching result, ensure that all validation errors are resolved before transmitting the ILR to the LSC.

To run the funding calculations from the Batch Import screen refer to Using Batch Import (see page 28).

Running the funding calculations using the Calculate Funding Data screen is described below. 

Note:  When calculating funding within LIS you must ensure you are using the latest available provider list.  The provider list contains information such as Area Cost Factor, Specialist College Factor and Long Term Residential Status for each provider.  The latest copy of the list is available for download from the LSC website’s Learner Information Suite pages.  To update data within LIS, refer to Updating LIS Data (see page 51).


Continued on next page

Calculating Funding Data, Continued
	Calculating your FE Funding
	To calculate FE funding first import and validate your ILR data file.

To complete the funding calculation:


	Step
	Action

	1
	Access the Calculate Funding Data screen. 


The Calculate Funding Data screen displays:



	2
	Click Calculate.

The LIS will run the FE funding calculations by:

· Exporting learner and aim data

· Exporting calculations lookups and census dates

· Calculating funding

· Importing calculation results

· Importing calculation steps

· Importing calculation errors.

Click Cancel to abort the calculation.

On successfully completing the calculations a confirmation message displays.



	3
	Click OK.

The calculations are complete.




Viewing Funding Data
	Overview
	Although the LIS cannot be used to amend ILR data, it can display learner records and funding data.


	Viewing your Learner Data
	Use the Funding Viewer to view the imported learner data and resulting funding calculations.


	Step
	Action

	1
	Access the Funding Viewer screen by selecting the Funding Viewer from the navigation tree.

The Funding Viewer screen displays.

Note:  No learner data is visible at this stage.




	Listing your Learner Data
	You can list all imported learner data.

To list all the data from the Funding Viewer screen:


	Step
	Action

	1
	Click on the All Records icon [image: image6.jpg]


 to list all records.

A list displays on the Learners tab and shows all imported data records for you to view.  Move through the list using the navigation buttons.

A scroll bar manifests if all the records are not visible.

Note:  At the start or the end of the list some of the navigation buttons will be active or inactive accordingly.

Note:  If more than 100 learner records are in the ILR, only the first 100 displays.  A message displays to advise you of this fact.  Click on OK to proceed.

Use the filter options for learner surname and learner reference to return more specific results.



	2
	Click on a learner in the list.

View the details for the selected learner in the header fields at the top of the Funding Viewer screen.

Refer to Viewing Learner Details (see page 46).




Continued on next page
Viewing Funding Data, Continued
	Navigating around the Funding Viewer screen
	The Funding Viewer screen has a series of ‘tabs’, each holding different sub-sets of data.

Common header information displays across the top of the screen.  This information is read-only and cannot be changed.

To navigate around the Funding Viewer:


	Step
	Action

	1
	Click on one of the data tabs:

The options available are:

· Learners

· Aims

· LAD Lookups

· Derived

· Funding

· Funding (No Disadvantage)

· Calculation Steps

· Errors.

Once one of the tabs has been selected, a sub-set of data is available or a further subset of tabs allows more data to be viewed.



	
	
	
	
	

	
	
	IF…
	THEN…
	

	
	
	You click on the Learners tab
	A list of learner records are available.


	

	
	
	You click on the Aims tab
	Aim details for the selected learner are available.


	

	
	
	You click on the LAD Lookups tab
	Funding details from the LAD about the learning aim are available.
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Viewing Funding Data, Continued
	Navigating around the Funding Viewer screen (continued)


	Step
	Action

	
	
	
	
	

	
	
	IF…
	THEN…
	

	
	
	You click on the Derived tab
	The following options are available:

· Base (Initial):  This data is taken from A52 for distance, e-learning, or NVQ in the workplace aims; the relevant National Base Rate field from the LAD for listed aims; or the relevant band based on guided learning hours for loadbanded aims.

· Base (Tapered/Scaled): The aim’s National Base Rate after any tapering or Traditional ESF (see fields A11 and A12) scaling.

· Base (Weighted):  The tapered, scaled national base rate, including Area Cost Factor, Disadvantage Factor, Programme Weighting Factor and Specialist College Factor.

· Fee Element:  25% of Base (Initial).

· Franch Disc:  Any applicable rate discount for franchising.

· Emp Disc:  Any applicable rate discount for employer dedicated provision.

· Taper Factor:  The amount by which the national base rate is tapered for each aim for each period.
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Viewing Funding Data, Continued
	Navigating around the Funding Viewer screen (continued)


	Step
	Action

	
	
	
	
	

	
	
	IF…
	THEN…
	

	
	
	You click on the Funding tab
	The following options are available:

· Core Funding:  The Weighted Base Rate with achievement, fee element, employer and franchising discounts removed.

· Achievement:  10% of the weighted national base rate.

· Fee Remission:  25% of the initial national base rate.

· Additional Support:  The value, divided per aim per period, of the band that the learner’s additional support cost falls into.

· Totals.


	

	
	
	You click on the Funding (No Disadvantage) tab
	This screen displays funding values with core and achievement funding calculated without the disadvantage uplift.

The following options are available:

· Core

· Core (No Disadv.)

· Achievement

· Achievement (No Disadv.)

· Fee Remission

· Additional Support

· Totals.
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Viewing Funding Data, Continued
	Navigating around the Funding Viewer screen (continued)


	Step
	Action

	
	
	
	
	

	
	
	IF…
	THEN…
	

	
	
	You click on the Calculation Steps tab
	The steps that the LIS uses to arrive at the funding calculation are available here.


	

	
	
	You click on the Errors tab
	This screen shows any Rule Violations or Calculation Errors.


	

	
	
	
	
	


	Searching for Learner Data
	You can search for specific imported learner data if required.  When using search within LIS you can use wildcards.  * will enable you to search using partial information.  ? can be used to represent individual characters when searching using partial information. 

To search for specific learner data:


	Step
	Action

	1
	From the Enter Search Text area, use the drop down to select a search type as either Surname or Learner Reference.



	2
	Enter a surname or learner reference into the Enter Search Text field, using wildcards if required.
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Viewing Funding Data, Continued
	Searching for Learner Data (continued)


	Step
	Action

	3
	Click the magnifying glass to start the search.



	
	
	IF...
	THEN...
	

	
	
	A match is found
	The result shows in the list.

The search results display the number of records matched and listed.  The search is complete.


	

	
	
	No match is found
	An error message displays.

Go to step 4.


	

	
	
	
	
	

	4
	Click OK and check your search text. 



	5
	Enter a valid search text using steps 1 to 3 as above.
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Reconciliation

	Overview
	The reconciliation process ensures that where a learner studies between two or more successive teaching years then the ILR data between years is consistent.
From two different ILR returns, the LIS identifies records for learners on the earlier return (eg ILRF04 for 2002/03) which are expected to be included on the later return (eg ILRF01 for 2003/04).  Where records are not present as expected an entry is produced on a reconciliation list.
Different providers can be selected for each of the files input for reconciliation.  This allows for provider number changes between teaching years.
Reconciliation can be run for:

· Mode F04/F01 – between 2002/03 F04 and 2003/04 F01 files.  
This produces a .F01 reconciliation file with the 2003/04 Provider Number and dated 03/04, ready for transmission

· Mode F05/F01 – between 2003/04 F05 and 2003.04 F01 files.
This produces a .F05 reconciliation file for internal provider use only with the 2002/03 Provider Number and dated 02/03.

Note:  File validation is carried out in accordance with the LSC published document LIS 11.03 Reconciliation Specification v1.1.


	Preparing to Reconcile your ILR Data
	To reconcile ILR data follow the steps below:


	Step
	Action

	1
	Access the Reconciliation screen by selecting Reconciliation from the Navigation Tree.

The Reconciliation screen is displayed.
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Reconciliation, Continued
	Preparing to Reconcile your ILR Data (continued)


	Step
	Action

	2
	Ensure that the Providers 1 and 2 fields display the correct provider number and name for the ILR data you wish to reconcile.

Note:  If the provider number does not match the provider reference within the ILR file name, the reconciliation process will be unsuccessful.



	
	
	IF...
	THEN...
	

	
	
	The Providers numbers and names are not correct


	Go to step 3 below.
	

	
	
	The Providers numbers and names are correct


	Go to step 6.
	

	
	
	
	
	

	3
	Click the Change button adjacent to the Provider 1 field boxes.

The Provider Selection box is displayed showing a list of provider numbers and names in alphabetical order.



	4
	To find your provider name, type the first few characters of the name into the Find field.  The list scrolls as you type until the provider name matches the characters typed.

You can also search by entering the whole provider number in the Find field.  Alternatively, use the vertical scroll bar to scroll to your provider name and number.

Highlight the entry in the list.

Click OK.



	5
	Click the Change button adjacent to the Provider 2 field boxes.

Follow steps 3 – 4 above.



	6
	Select the Mode of reconciliation:

· F04/F01

· F05/F01.
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Reconciliation, Continued
	Preparing to Reconcile your ILR Data (continued)


	Step
	Action

	7
	When selecting a file for reconciliation:



	
	
	IF...
	THEN...
	

	
	
	This is the first time you have selected a file for reconciliation
	The Files selected to reconcile fields will be blank.

Go to step 8.


	

	
	
	A file has been reconciled previously
	The fields will contain those details.

They can be removed using the Delete Files facility as described in step 11.


	

	
	
	
	
	

	8
	Click the Add Files… button in the Reconciliation File 1 – F04 area.  The Select ILR file to reconcile window displays.

Navigate to the directory that contains the ILR file to be reconciled and select the file.  Only one file can be added.

Note:  If an incorrect provider, collection type or collection period have been selected, or if the file is not named correctly, the files will not be visible.



	9
	Click OK.

You return to the Reconciliation screen.  The Reconciliation File 1 – F04 and Files selected to reconcile field displays details of the file selected for reconciliation.

Note:  Any ILR data already present within LIS will be deleted when the new data is imported.  LIS copies the ILR data file selected – the original file is not affected.



	10
	Click the Add Files… button in the Reconciliation File 2 – F01 area and follow steps 8 – 9.



	11
	You can delete the files from the Files selected to reconcile fields.

Select the file you wish to delete.

Click Delete Files and the file is removed from the field.
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Reconciliation, Continued
	Exporting Reconciled Data 
	Within the Operations area of the Reconciliation screen you have the facility to export the reconciled data to a location in your directory or on to floppy diskettes.

To export the file to a folder on your PC.  The default location is C:\LIS\Release11\1103\exports.   Follow the steps below:




	Step
	Action

	1
	In the Operations area of the Reconciliation screen.



	
	
	IF...
	THEN...
	

	
	
	You want to change the directory to which the reconciliation data exports


	Go to step 2.
	

	
	
	If you want the directory for the reconciliation export to remain the same


	Go to step 4.
	

	
	
	
	
	

	2
	Click Change….

The Select Export File Path window displays.



	3
	Use the explorer window to navigate to and select the directory for your reconciliation data export and click OK.

You return to the Reconciliation screen and the details of the directory selected for the reconciliation export are displayed.



	4
	You can also export to a floppy diskette(s) if required.  A disk must be inserted into the drive. 

Click the Export to floppy checkbox.

Once the first diskette is full, LIS displays a message informing you how many diskettes are required to complete the export.

Note: The LIS will not burn a file to CD.
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Reconciliation, Continued
	Reconciliation Report 
	At the time of export you may wish to run the Reconciliation Report:


	Step
	Action

	1
	Click the Reconciliation Report checkbox.

The report will be output to the default printer.


	
	
	IF...
	THEN...
	

	
	
	No printer is available
	A suitable error message will be displayed.

Click OK to clear and the process will be cancelled.


	

	
	
	The report is over 500 entries
	A message will appear asking if you wish to print the report now or later.


	

	
	
	
	
	

	
	The report output is stored in the Reconciliation database and can be printed from the Report Manager at anytime after the reconciliation has been performed, until a new reconciliation is run and the stored data replaced.

For running reports from the Batch Import screen refer to Using Batch Import - Select Reports (see page 39).
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Reconciliation, Continued
	Running the Reconciliation Process 
	To start the reconciliation process:




	Step
	Action

	1
	Click the Reconcile button.

The process starts.  Status and progress are displayed.



	
	
	IF...
	THEN...
	

	
	
	You receive an import error message
	Click OK to clear.

The reconciliation process will be aborted.


	

	
	
	The process is aborted for any reason
	A dialogue box will appear with the message The Reconciliation process has aborted.  

Click OK to close the box.


	

	
	
	You receive confirmation that the process has completed successfully


	Click OK to close the box.
	

	
	
	
	
	

	
	The imported data files and output data file will be stored in separate tables in the LIS database.

On subsequent reconciliation operations, the stored data will be automatically deleted and replaced by the new data.




	Cancel the Reconciliation Process
	Click the Cancel button to cancel the process at any time while it is running.  

Note:  Before the process is started, and after it has run, the button is de-activated.


	Delete Reconciliation Data
	The stored reconciliation data can be manually deleted via the Menu option Delete Reconciliation Data in the Data menu.


Running Reports

	Overview
	There are two ways in which you can run reports from the LIS, using either the:

· Batch Import screen; or

· Report Manager screen.

For running reports from the Batch Import screen refer to Using Batch Import - Select Reports (see page 39).

The Batch Import screen outputs reports directly to a printer, whereas the Report Manager outputs reports to a print preview window.


	Available Reports
	· The Rule Violations report – lists ILR rule violations produced during the validation process.  Includes the rule name, description, warning and FE funding rule statuses and the ILR data which caused the rule violation.  Includes a summary count of the number of invalid learners.

· The Rule Violations by LSC report – lists ILR rule violations produced during the validation process by local LSC codes used in field L25.  Includes the rule name, description, warning and FE funding rule statuses and the ILR data which caused the rule violation.  Includes a summary count of the number of invalid learners.

· The Rule Violations Summary report – outputs, for each validation error generated by the ILR data during the validation process, a count of the number of instances found in the ILR data.  Also indicates whether a rule is a warning or FE funding rule.  Includes a summary count of the number of invalid learners.

· The Rule Violations Summary by LSC report –outputs, for each validation error generated by the ILR data during the validation process, a count of the number of instances found in the ILR data, listed by local LSC code in field L25.  Includes a summary count of the number of invalid learners.

· The Mini ILR Validation Rules report – lists all mini ILR data validation rules used by LIS.

· The Full ILR Validation Rules report – lists all validation rules used by LIS.

· The Summary of Funding by Learner report –summarises funding for every learner.  This report can be very long and should be filtered.

· The Summary of Funding by Category report – outputs the total funding for a provider classified by period and category.

· The Summary of Funding with Disadvantage report - outputs the total funding for a provider classified by period, category and including disadvantage uplift.
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Running Reports, Continued
	Available Reports (continued)
	· The Calculation Steps report – details the steps used to calculate funding aim by aim for each learner.  This report can be very long and should be filtered.

· The Calculation Errors report – outputs a summary report for all funding calculation errors in the ILR file. 

· The Detailed Learner and Aim Funding report – provides funding information from the ILR and provider list and details funding for each learner by Aim and Period.  This report can be very long and should be filtered.

· The Learning Aim Funding report – produces all funding details for every learner.  This report can be very long and should be filtered.

· The Learning Aim Summary 1 – provides the total funding by the first provider specified aim field and category. 

· The Learning Aim Summary 2 – provides the total funding by the second provider specified aim field and category.The Learning Aim Summary 3 – provides the total funding by both provider specified aim fields and category.

· The Learner Summary 3 report – provides total funding by category and both provider-specified learner fields.

· The Funding Included and Excluded by ILR Export report – provides funding by category and period for fully valid learners, who are included in the export and other learners, who are not included in the export.

· The Summary by Allocation Type report – outputs the total funding by allocation type, category and period.

· The Summary by Franchised Out Arrangement report – outputs the total funding by franchised-out arrangement, category and period.

· The Learner Profile report – provides a breakdown of the learners in the file according to derived variable calculations.  See the Guidance on Interpretation of Results for the Termly Learner Profile for further information on the report and the derived variables. 

· The Funding by Learner Profile Category report – lists funding by learner profile group.

· Learner Export – exports ILR learner data from LIS in a format that providers can use (e.g. in Excel).  This export includes the following fields: ProcessID (internal LIS procedure number, does not affect funding), L01, L02, L03, L09, L10, L42a, L42b. 
The export includes derived variable and funding information (see the Guidance on Interpretation of Results for the Learner Profile for explanation of these derived variables): l_ageb, l_ftelp, l_mode_b, l_bskill; core funding per period, core funding without disadvantage per period, achievement funding per period, achievement funding without disadvantage per period; fee remission per period; additional support per period, per period totals.
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Running Reports, Continued
	Available Reports (continued)
	· Aim Export – exports ILR aim data from LIS in a format that providers can use (for example, Excel).  This export includes the same ILR fields, derived variables and funding information as the learner export, but includes additional ILR fields: aim sequence (A05), A09, A48a and A48b.

· The Missing from Later Return – lists all continuing non-WBL learners missing from the later return.


	Using Report Manager
	From Report Manager, select, run, print and export available reports.

To access Report Manager:


	Step
	Action

	1
	Access the Report Manager screen by selecting Report Manager from the navigation tree. 

The Report Manager screen displays.




	Selecting and Running a Report
	You can only run one report at a time from Report Manager.  To run multiple reports simultaneously, use Batch Import, but note that these reports output directly to a printer.

Reports displayed in the Available Reports list depend upon the type of data currently held within LIS.

To use Report Manager to select and run a report:


	Step
	Action

	1
	From the list of Available Reports select the one you require by clicking on the report.  On selection the report will be highlighted.

Note:  The filters change in the lower area of the screen as you select different reports from the list. 

For more details on filters see Running Filtered Reports (see page 51).
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Running Reports, Continued
	Selecting and Running a Report (continued)


	Step
	Action

	2
	Click on the Run Report button.

The report output displays in a print preview window.

The toolbar at the top of the report window enables you to:

· Zoom the view and navigate through the report pages

· Print or export the report output.
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Refer to:

· Printing a Report (see page 51)

· Exporting a Report (see page 51).
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Running Reports, Continued
	Using Filters in Reports
	Filters restrict the amount of data returned in a report.  The filters vary for each report and display when a report is highlighted in the list.  

The filter values used must be valid or the report output will be affected.  It is useful to use filters when reporting on large sets of data.

You may use wildcards (*, % or ?) when populating filter fields.


	Available Filters for Reports
	There are a number of filters available when running reports.  Filters vary from report to report.  

The following table shows a list of reports which use filters, and which filters are available for each. Where a report is not listed below, there are no filter options available.


	Report Name
	Available Filters

	
	Learner Ref
	Rule Name
	Funding Rule
	Warning
	Provider Specified Learner Data (1)
	Provider Specified Learner Data (2)
	Provider Specified Aim Data (1)
	Provider Specified Aim Data (2)
	Error Code
	Learning Aim Reference

	Rule Violations
	x
	x
	x
	x
	x
	x
	x
	x
	
	

	Rule Violations by LSC
	x
	x
	x
	x
	x
	x
	x
	x
	
	

	Rule Violations Summary
	
	
	x
	x
	
	
	
	
	
	

	Rule Violations Summary by LSC
	
	
	x
	x
	
	
	
	
	
	

	Summary of Funding by Learner
	x
	
	
	
	x
	x
	
	
	
	

	Calculation Steps
	x
	
	
	
	x
	x
	
	
	
	

	Calculation Errors
	x
	
	
	
	
	
	
	
	x
	

	Detailed Learner and Aim Funding
	x
	
	
	
	x
	x
	
	
	
	

	Learning Aim Funding
	
	
	
	
	
	
	x
	x
	
	x

	Learning Aim Summary 1
	
	
	
	
	x
	x
	x
	x
	
	

	Learning Aim Summary 2
	
	
	
	
	x
	x
	x
	x
	
	

	Learning Aim Summary 3
	
	
	
	
	x
	x
	x
	x
	
	

	Learner Summary 3
	x
	
	
	
	x
	x
	
	
	
	

	Aim Details Export
	x
	
	
	
	
	
	x
	x
	
	x

	Learner Details Export
	x
	
	
	
	x
	x
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Running Reports, Continued
	Recommended Field Values for Filtering
	The following table describes the valid values you can use for each of the filter fields in the reports:


	Filter Name
	Acceptable Value

	Learner Reference
	Full or partial Learner Reference Number (ILR field L02).



	Rule Name
	Full or partial rule name, as listed on the Validation Rules screen.



	Funding Rule
	Y returns results where the rule is an FE funding rule; N returns results where the rule is not a funding rule.



	Warning
	Y reports warnings, N reports only errors.  



	Provider Specified Learner Data (1)
	Uses a field value or part of one. (Refer to the ILR Field Specification document, which describes this field, L42a.)



	Provider Specified Learner Data (2)
	Uses a field value or part of one.  (Refer to the ILR Field Specification document, which describes this field, L42b.)



	Provider Specified Aim Data (1)
	Uses a field value or part of one.

(Refer to the ILR Field Specification document, which describes this field, A48a.)



	Provider Specified Aim Data (2)
	Uses a field value or part of one.

(Refer to the ILR Field Specification document, which describes this field, A48b.)



	Error Code
	Error code number, available from the database table error codes.



	Learning Aim Reference
	Learning Aim Reference (A09).  This can be entered partially or fully.
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Running Reports, Continued
	Running Filtered Reports
	To filter reports, follow the steps below:

Note:  Filtered reports can also be run using the print icon from the ILR Data Viewer screen, which pre-populates the learner reference filter.


	Step
	Action

	1
	Access Report Manager by selecting Report Manager from the navigation tree. 

The Report Manager screen displays.



	2
	Select the required report from the Available Reports list. 

Use the Clear Filters button if the filters are populated and you do not want to use the current settings.



	3
	Enter a valid value in the filter field. 

Repeat for as many filters as required.

 

	4
	Click the Run Report button. 

The report output displays in a print preview window.

In the Filters section of the report header the filters used in this report are populated.

The report output can now be printed or exported.  Refer to Printing a Report (see page 51) or Exporting a Report (see page 51).



	5
	To remove all values entered in the filter fields of the report, click the Clear Filters button.
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Running Reports, Continued
	Printing a Report
	Within LIS there are two possible ways of printing reports, either using:

· Batch Import; or

· Report Manager.

When running reports from the Batch Import screen, the report output is directed to the default printer.  This should be used with caution as some reports can be several hundred pages long.

When using Report Manager the report output displays on screen first.  The user can print the report if required. 

Reports can be exported and printed using another application.  Exported reports can also be saved.

The following steps describe how to print reports from Report Manager:


	Step
	Action

	1
	From Report Manager select a report, set any required filters and click on the Run Report button. 

The report output displays in the print preview window.



	2
	Click Print [image: image8.png]


 from the top of the report output window.

The Print dialogue box displays.

Select the print range for the number of pages to print, select the number of copies required and ensure the collate copies option is correctly set.



	3
	Click OK.

The report output is printed to the default printer.

Cancel closes the print dialogue box and does not print the output.
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Running Reports, Continued
	Exporting a Report
	It is possible to export report outputs to a variety of formats. 

Use the following steps to export report output: 


	Step
	Action

	1
	It is assumed you have already produced a report output from Report Manager.



	2
	Click Export [image: image9.png]


.  The Export dialogue box appears.



	3
	Select an item from the drop down Format list.  The default format is PDF.  Use the vertical scroll bar to see the whole list.



	4
	Select an item from the Destination drop down list.  The default is to save the item to disk.



	5
	Click OK.

The Export Options dialogue box displays.



	6
	Select the pages to export.  The default is to export the whole report.



	7
	Click OK.

The Choose export file dialogue box displays.

You may change the location, file name or format of the exported report.



	8
	Click Save.

The report exports to the specified location.  View the report from that location by accessing the exported report file using Windows Explorer or an appropriate application.




Export ILR File

	Overview
	This facility exports the ILR data in a format suitable for transmission to the LSC.

To export ILR data, use either the:

· Batch Import screen; or

· Export ILR File screen.

Note:  The Export ILR File feature exports valid ILR data ONLY and any invalid records WILL NOT export.  The export file must therefore be viewed with the knowledge that it contains valid records only and may not be a reflection of the originally imported ILR data file.

It is therefore important that you ONLY export the ILR data when all errors have been corrected and the file is fully validated. 

At the time of export you may ‘Run Report Showing Funding Included and Excluded by ILR Export’.

The Batch Import screen allows you to select an operation to export validated ILR data as part of the import/validate process, or separately.  Refer to the Export ILR section of Using Batch Import (see page 36).


	Exporting ILR Data using ILR Export
	Export ILR data using the Export ILR File screen. 

The Export ILR File screen makes exporting to floppy diskettes easier by displaying the number of floppy diskettes you will require for the ILR file.

Note:  When exporting to floppy diskettes you must ensure they are blank, formatted diskettes with at least 1.44MB capacity.

To export ILR data using the Export ILR File screen:


	Step
	Action

	1
	Access the Export ILR File screen by selecting Export ILR File from the navigation tree.

The Export ILR File screen displays.  The fields on this screen are mainly read-only.  They are populated with information from the imported file.



	2
	You may choose to change the Data Type by selecting one of the radio buttons.  This will be set to Live by default.




Continued on next page

Export ILR File, Continued
	Exporting ILR Data using ILR Export (continued)


	Step
	Action

	3
	

	
	
	IF...
	THEN...
	

	
	
	You would like to export to floppy diskettes
	Click the Export to floppy diskettes? checkbox.

The Diskette Count field populates with the number of diskettes required by the export.

Note:  Where more than one floppy diskette is required you will be prompted to insert each floppy diskette during the export.


	

	
	
	You would like to export to a file on your PC’s hard drive
	Uncheck the Export to floppy diskettes? checkbox.


	

	
	
	You would like to Run Report Showing Funding Included and Excluded by ILR Export
	Click the Run Report Showing Funding Included and Excluded by ILR Export checkbox.

Note:  This report will be output to the default printer.


	

	
	
	You click Cancel
	The export process aborts.


	

	
	
	
	
	

	4
	Click on the Change… button to select a different Export Area.

Select an Export Area path and click OK.
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Export ILR File, Continued
	Exporting ILR Data using ILR Export (continued)


	Step
	Action

	5
	Click on the Export button. 

The export begins and a confirmation prompt appears.



	6
	Click OK.

The export is complete.  You can now access the exported ILR file using Windows Explorer and transmit it to the LSC, or you can access it with any application supporting the file type.

Note:  Only valid ILR data exports.  An information message displays confirming the number of records not exported.  Where WBL ILR records export, the message reads “If you transmit this file, you will delete X learner records from the records held by the LSC”.  X represents the number of learner records not included in the export which were present in the import.




Validation Rules

	Overview
	LIS uses a set of full and mini validation rules in conjunction with the LAD to validate the imported ILR data.  Using LIS 11.03, full ILR data is validated against release 3 of the 2003/04 ILR validation rules and mini ILR data is validated against 2003/04 mini ILR validation rules.

For details about the validation rules and the amendments since previous releases, please refer to the Data area of the Partners section of the LSC website (www.lsc.gov.uk).


	Listing all Validation Rules
	The Validation Rules screen lists all the rules applied by the LIS for both full and mini ILR data.

To list all the validation rules:


	Step
	Action

	1
	Access Validation Rules by selecting Validation Rules from the navigation tree. 

The Validation Rules screen displays.



	2
	Use the scroll bar to move up and down the list and view the rules.

The validation rules are listed in the following format:

· Full ILR

· Mini ILR

· Both.
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Validation Rules, Continued
	Viewing Validation Rule Properties
	View additional information for each validation rule listed in the Validation Rules screen. 

To view properties for a selected validation rule:


	Step
	Action

	1
	Scroll the list to find the rule you are searching for and double click the rule.

The Validation Rule Properties dialogue box displays.



	2
	Once you are finished, click Cancel.

The dialogue box closes and you return to the validation rules screen.




	Reports showing Full and Mini ILR Validation Rules 
	The Full ILR Validation Rules report and the Mini ILR Validation Rules report prints the validation rules.

To run these reports, follow the procedure described in Running Reports 
(see page 51).




Maintaining LIS Options

	Overview
	There are several options which may be viewed and/or maintained from within LIS 11.03.  They are accessed via the Options screen.  These are described in this section.


	Accessing the Options screen
	To access the Options screen:


	Step
	Action

	1
	Access the Options screen by selecting Options from the navigation tree.

The Options screen displays.

By default the screen opens on the Status Information tab.




	Viewing Status Information
	You can view status information for the data currently held in the database. 

The following steps describe this: 


	Step
	Action

	1
	It is assumed you have accessed the Options screen.

Click on the Status Information tab if this is not displayed.

The status information displays.  Up to 10 entries display.

From this screen you can view:

· the selected provider

· details for the most recently completed processes

· the number of learners imported.



	2
	To see a list of all processes that have taken place, click the Show History checkbox at the bottom of the screen.

The history information displays.
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Maintaining LIS Options, Continued
	Maintenance Options 
	The Maintenance tab screen within Options allows you to carry out some maintenance tasks within LIS.

Use the following steps when using the Maintenance tab from the Options menu:


	Step
	Action

	1
	Access the Options screen.  Click the Maintenance tab.

The Maintenance tab screen displays.

The Maintenance tab offers the following options:

· Provider Selection

· Truncate Log

· Clear Locks

· Compact DB

· Update Data.



	2
	Click on a button to conduct a specific operation.



	
	
	IF...
	THEN...
	

	
	
	You wish to change your provider, click on the Provider… button


	Go to Change the Provider (see page 31).
	

	
	
	You wish to truncate the log file click on the Truncate Log button


	Go to Truncating the Log (see page 51).
	

	
	
	You wish to clear locks click on the Clear Locks button


	Go to Clearing Locks 

(see page 51).
	

	
	
	You wish to compact the database click on the Compact DB button


	Go to Compacting the Database (see page 51).
	

	
	
	You wish to update the data used by LIS click on the Update Data button


	Go to Updating the LIS Data (see page 51).
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Maintaining LIS Options, Continued
	Truncating the Log
	The LIS logs events and operations.  Refer to Viewing the Audit Log for more information (see page 51).  The log file is useful for diagnosing problems, but it can be truncated if required.  Truncating the log restricts the view to the last seven days of entries only and saves hard disk space. 

To truncate the log file:


	Step
	Action

	1
	Access Options screen by selecting Options from the navigation tree.

Select the Maintenance tab.

Click on the Truncate Log button.

A warning message displays advising you that this process is not reversible. 



	2
	Select an option:



	
	
	IF...
	THEN...
	

	
	
	You click OK.
	A confirmation message displays.

The truncation is complete.

Go to step 3.


	

	
	
	You click No.
	You return to the Maintenance tab and no truncation has taken place.


	

	
	
	
	
	

	3
	Click OK. You return to the Maintenance tab.
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Maintaining LIS Options, Continued
	Clearing Locks
	Locks occur within LIS when processes remain incomplete or are aborted, for example, if your PC is switched off during import.  Error messages will prevent you from completing some operations.  If this occurs then the Clear Locks option should be used. 

To clear locks:


	Step
	Action

	1
	Access Options screen by selecting Options from the navigation tree.  Select the Maintenance tab.  Click on the Clear Locks button. 

A warning message displays advising you that this process is not reversible.



	2
	Select an option.



	
	
	IF...
	THEN...
	

	
	
	You click OK.
	A confirmation message displays.

Go to step 3.

	

	
	
	You click No.
	You return to the Maintenance tab screen and no locks have cleared.


	

	
	
	
	
	

	3
	Click OK. You return to the Maintenance tab screen.
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Maintaining LIS Options, Continued
	Compacting your Database
	You can compact the database within LIS to save hard disk space.  However, the LIS performs self-compaction after validation so this option is generally necessary for providers with exceptionally large files. 

To compact the database:


	Step
	Action

	1
	Access Options screen by selecting Options from the navigation tree.  Select the Maintenance tab.  Click on the Compact DB button. 

You will be asked to confirm that you want to compact the database.



	2
	Select an option.



	
	
	IF...
	THEN...
	

	
	
	You click Yes.
	A confirmation message displays.

Go to step 3.


	

	
	
	You click No.
	You return to the Maintenance tab screen and the database has not compacted.


	

	
	
	
	
	

	3
	Click OK. You return to the Maintenance tab.
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Maintaining LIS Options, Continued
	Updating your LIS Data
	This feature enables you to update the static data used by LIS, for example the Provider list or Postcode list.  You will only need to do this when an update is released via the Data section of the LSC website.

To update the LIS database:


	Step
	Action

	1
	Download the updated data file from the LIS pages of the LSC website to your PC.


	2
	Access Options screen by selecting Options from the navigation tree.  Select the Maintenance tab.  Click the Update Data button. 

The Select lookups update file dialogue box displays.



	3
	Select the update file.



	4
	Click OK.

The selected file updates the LIS.




	Viewing Import Errors
	You can view a list of import errors in the imported data:


	Step
	Action

	1
	Access Options screen by selecting Options from the navigation tree.  Select the Import Errors tab.

The import errors tab screen displays.



	2
	Click on an error in the list for more details.
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Maintaining LIS Options, Continued
	Viewing Version Information
	You may need to know which version of the LIS and the LAD you are using  when updating software, maintaining LIS data or requesting support. 

To view version information from within the LIS application:


	Step
	Action

	1
	Access Options screen by selecting Options from the navigation tree. Click the Version Information tab.

The version information tab screen displays.

The screen is read only and shows version information for:

· Learner Information Suite

· Database

· Application

· Validation Rules

· Learning Aim Database

· Funding Calculation Module

· Derived Data Module.
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Maintaining LIS Options, Continued
	Maintaining Postcodes
	Postcodes can be maintained within LIS.  You can search existing postcodes or insert new postcodes into the list.

Note:  Use a wildcard (%) when searching on a partial outward postcode or description.


	Searching for Postcodes
	To search for postcodes:


	Step
	Action

	1
	Access the Postcodes by selecting Postcodes from the navigation tree.

The Postcodes screen displays.

The list shows all postcode records to view.  Move through the list using the scroll bar or the navigation buttons.



	2
	If you click the drop down next to the search button you have two options:



	
	
	IF...
	THEN...
	

	
	
	You click All Records.
	The list refreshes to display all postcode records. 


	

	
	
	You click Some Records.
	The Select Filter Required dialogue box displays.

Go to step 3.


	

	
	

	3
	Click on the drop down for Data Field to select a category for your search.

Three filter options are available:

· Council Entered

· Description

· Outward Postcode.
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Maintaining LIS Options, Continued
	Searching for Postcodes (continued)


	Step
	Action

	4
	Enter a value in the Filter field.

Note:  Use the wildcard to search for a partial entry for Outward Postcard or Description.



	5
	Click on the Filter button.

Your search results display.

Cancel stops the search.




	Inserting New Postcodes
	It is possible to insert new postcodes into the list within LIS.

To insert new postcodes:


	Step
	Action

	1
	Click Insert [image: image10.png]=3



.

The Postcode screen displays.



	2
	Enter Outward Postcode in the field.



	3
	Enter a Description for the postcode.

Note:  The inserted postcode defaults Council Entered to N.

The entry displays at the end of the existing list.



	4
	Click Discard 
[image: image11.png]


 if the Insert button has been pressed by mistake or you do not want to save the postcode.



	5
	Click Save Changes [image: image12.png]


.

The new postcode is inserted into the list.  The list is sorted by Outward Postcode when it is saved.
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Maintaining LIS Options, Continued

	Deleting New Postcodes
	It is possible to delete a postcode which has been added to the list within LIS.

Note:  You can only delete postcodes that have been inserted.

To delete a new postcode:


	Step
	Action

	1
	Search for the required new postcode, or select it in the list of postcodes.



	2
	Click on the Delete button [image: image13.png]* X



.

The selected new postcode will be deleted.




Viewing the Audit Log

	Overview
	The Audit Log lists the events and operations carried out by the LIS.  The log updates automatically whenever an operation is completed and stores the following information:

· Date – the date and time when the log entry took place

· Module – the module the operation occurred in

· Function – the function which was performed

· Message – a description of the log entry message.

The audit log (LISlog.txt) is stored in the installation directory of LIS by default.  The information may be useful for diagnosis if problems have occurred.  The audit log can also be viewed from within LIS. 
The log can be truncated; refer to Truncating the Log (see page 51).


	Viewing the Log 
	To view the log file from within the LIS:


	Step
	Action

	1
	Access the Log screen by selecting Log from the navigation tree.

The Log screen displays.

If required you can use the vertical scroll bar to view other operations at the bottom of the list.




Technical Information

	Overview
	This section describes how to examine the data stored by LIS.


	Looking at Data Stored by LIS
	The LIS provides the Export DB function to allow the user to view and manipulate the data held within the internal LIS database. 

The export database function does not create a file that is suitable for transmission to the LSC.  Files sent to the LSC must be exported via ILR Export.

LIS stores data in Microsoft Access.  The file is called LISData.mdb and can be found in C:\LIS\Release11\1103\Data if the default directory structure is used at the time of installation.  The file is read-only.  You can access the database using the LIS database shortcut on your desktop.  This is automatically created the first time you use the software after installation.  To view the data held in the database, the password for read-only access is the same as the LIS password.

To manipulate the data held in the database, users must export the database.  This exports data stored within the LIS programme in one of three formats: as a Microsoft Access 97 file (MDB format), as dBase III files (DBF format) or as comma separated values (CSV format).

You can export most of the lookup tables from the LIS internal database.  These correspond to various ILR fields and other static lookups.  The lookup table names roughly correspond to ILR field titles.  The LIS Technical Database Guidance, which describes many of the exported tables, is available to download from the LIS page of the LSC website.

If exporting in dBase format (.DBF file), there is an option to use short file names rather than long file names.  This is to assist users of Microsoft Access 97, which does not appear to support use of DBF files with long file names.

Access the Export Database function by:

· Using Batch Import; or

· Using Report Manager.


	Database Export using Batch Import
	To export the database using Batch Import, see the Export DB (database) section (see page 38).
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Technical Information, Continued
	Database Export using Report Manager
	To export the database using Report Manager:


	Step
	Action

	1
	Access the Report Manager screen by selecting Report Manager from the navigation tree.  The Report Manager screen displays.



	2
	Click on the Export DB button.  The Export Database dialogue box appears.



	3
	Use the Default Export Settings or select your own:



	
	
	IF...
	THEN...
	

	
	
	You have the Use default export settings? checkbox checked
	Select an Export Type from the list by clicking the appropriate radio button.  Each time a table exports, the LIS asks for an Export Type for that table.


	

	
	
	You uncheck the Use default export settings? checkbox
	The Export Type options are disabled and all tables export in the same format.


	

	
	
	You check the Use short files names for DBF export checkbox


	Short file names will be used in the export.
	

	
	
	You uncheck the Use short files names for DBF export checkbox


	Maintains default settings for file names.
	

	
	
	
	
	

	4
	The export path is read-only.  Click OK. 

Cancel stops the database export.



	5
	A confirmation message displays after exporting the database.  Click OK.


	


Command Line Option

	Overview
	The Command Line option allows you to run background batch operations using the saved defaults (from the Batch Import screen) within LIS.

This operation can be called from an MS-DOS command line prompt, which will run immediately, or the Schedule Tasks icon in the Control Panel, that allows you to run the operation at a specified time and date.

The syntax for the command line is:  

LIS.exe –i <import dir> -r <programme to run>

The <import dir> specifies the location of the import files and <programme to run> specifies the command to be executed.

A space is required between the programme name ‘LIS.exe’ and the first parameter, but no further spaces are required.  It is, however, recommended that spaces are used for readability.  The parameters can be placed in any order.

For example:
C:\LIS\Release11\1103\LIS.exe –i C:\LIS\Release11\1103\Data –r Notepad.exe 

This will execute LIS, using the C:\LIS\Release11\1103\Data directory as its target import (-i command) and will select all suitable files from that directory based on the selected Provider, Collection Type and Collection Period.
When completion has been successful, it will close and execute the follow-on command to run (-r command) Notepad.

All error messages when running LIS in command line option will be suppressed.  All suppressed error messages will be written to the LIS log file.  An entry will be created for each auditable operation in the audit log.

Note:  Windows 98, NT and ME do not have a built in Task Scheduler option.


	Preparing LIS to run the Command Line Option
	To prepare LIS to run the command line option follow the steps below:


	Step
	Action

	1
	Launch LIS 11.03 from your desktop and navigate to the Batch Import screen.  The Batch Import screen is displayed.
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Command Line Option, Continued
	Preparing LIS to run the Command Line Option (continued)


	Step
	Action

	2
	Select the following import options:

· Provider number and name

· Collection and type

· Learning Aim Database

· At least one operation.

Note:  These options are mandatory and must be selected before attempting to run the Command Line option.



	3
	Select any of the optional extras:

· Mini ILR

· Type of validation

· Export options

· Report options.

Note:  Any files that have been selected and are shown in the display window of ‘Files selected to import’ will be over-ridden by the <–i command> during the background run.



	4
	Click the Save Defaults button.



	
	
	IF...
	THEN...
	

	
	
	The Saved Defaults are not set on the Batch Import screen
	When you run the batch operation an external log file will be populated with the error ‘Default Settings not set – LIS Batch Operation cancelled’.


	

	
	
	The Saved Defaults are set on the Batch Import screen
	When you run the batch operation it will run successfully.


	

	
	
	
	
	

	5
	Exit the application.

To ensure integrity of the data in the database, LIS must be closed before the command line function will execute.  If LIS is running on your machine, the external log file will be populated with the error ‘LIS already in use – LIS Batch Operation cancelled’.
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Command Line Option, Continued
	Running an MS-DOS Prompt
	To set up an MS-DOS prompt follow the steps below:


	Step
	Action

	1
	Click Start from the task bar at the bottom of your screen.



	2
	Select Programs > Accessories > Command Prompt.


[image: image14.png]B Command Prompt




The Command Prompt box is displayed.



	3
	The C:\ prompt flashes.

Add the command line syntax.


	4
	Press Enter to run the LIS operation.



	5
	You can stop the operation from the LIS Batch Import screen.

Press Cancel.




	Setting up a Task using Windows 2000 
	To set up a task using Windows 2000 Task Scheduler follow the steps below:


	Step
	Action

	1
	Click Start from the task bar at the bottom of your screen.



	2
	Select Settings, then Control Panel.  When the Control Panel box opens, double click Scheduled Tasks.


[image: image15.png](8] Scheduled Tasks




The Scheduled Tasks box is opened. 



	3
	Click Add Scheduled Task to start the Scheduled Task Wizard.

The Wizard helps you to schedule a task for Windows to perform.

Click Next to continue.
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Command Line Option, Continued
	Setting up a Task using Windows 2000 (continued)


	Step
	Action

	4
	A list of programmes are displayed.

Click Browse and the Select Program to Schedule box is displayed.

Click LIS > Release 11 > 1103 > LIS.exe

LIS.exe populates the Filename field.



	5
	Click Open and the box closes.

LIS can be seen in the task name field in the Wizard.



	6
	Select the radio button for the performance of the task, One time only.

Click Next to continue.



	7
	Select the time you want the task to start.

The 24 hour clock is displayed.



	
	
	IF...
	THEN...
	

	
	
	You want to change the hour figures
	Use the drop up and down arrows to select an hour.


	

	
	
	You want to change the minute figures
	Use the drop up and down arrows to select the minutes.


	

	
	
	
	
	

	
	Click Next to continue.



	8
	Enter your user name, password and confirmation of your password in the fields provided.

This ensures that the task is run as if it were started by you.



	9
	Click Next to continue.

Wizard informs you that you have successfully scheduled the task for a specific time and date.

Click the checkbox Open advanced properties for this task when I click Finish.
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Command Line Option, Continued
	Setting up a Task using Windows 2000 (continued)


	Step
	Action

	10
	Click Finish.

The LIS box is displayed.



	11
	Enter the command line syntax in the Run field box and click OK.

For example:  


C:\LIS\Release11\1103\LIS.exe –iC:\LISData – r cmd/c”echo done > C:\done.txt.

This example will instruct LIS to look in the C:\LISData directory for any files which meet the criteria specified on the Batch Import screen.  When the import is complete a command is run which will create a text file named “done.txt” in the C:\ directory.

The LIS box closes.



	12
	The scheduled task is shown as an icon in the Scheduled Tasks box.


[image: image16.png]agus




Click once on the icon and the following LIS details are shown:

· Schedule
time and date

· Next Run Time
time and date

· Last Run Time
time and date

· Last Result

· Creator
your username.



	13
	Close the Scheduled Tasks box by clicking on the cross in the top right-hand corner of the screen.




Continued on next page

Command Line Option, Continued
	Cancelling a Task Set-up using Windows 2000
	To cancel a task that is set to run at a specific time and date, follow the steps below:


	Step
	Action

	1
	Click Start from the task bar at the bottom of your screen.



	2
	Select Settings, then Control Panel.  When the Control Panel box opens, double click Scheduled Tasks.

The Scheduled Tasks box is opened. 



	3
	Double click on the LIS icon.

The LIS box is displayed with the Task tab open.

At the bottom left-hand side, the Enabled (scheduled task runs at specified time) checkbox is ticked.



	4
	Click the checkbox to untick the field.

The Apply button is now enabled (not greyed out).



	5
	Click Apply and then click OK.

The LIS box closes.

The LIS icon in the Scheduled Tasks box is now disabled.
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	6
	Click once on the LIS icon.

The LIS details displayed on the left-hand side of the box are shown as being disabled.
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